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ICC Configuration Studio Version Info 
 
 
 

 07.31.2025 

• V3.8.3.0 Release 

• Added support to PicoPort and Mirius Siemens FLN Master and Slave for device addresses and 
point numbers up to 255. 

• Increased A.O. Smith AIN Slave Block Number setting limit from 29 to 255. 

• Fixed regression issue introduced by V3.7.3.0 where devices cannot be recovered when in 
bootloader mode. 

• Updated A.O. Smith AIN Slave, Macurco Modbus Monitor, Siemens FLN Master, and Siemens 
FLN Slave driver manuals. 

 
 
 

 01.13.2025 

• V3.7.3.0 Release 

• Reduced BACnet object memory usage for PicoPort and Mirius. 

• Increased allowable size of BACnet MS/TP Server objects’ Object Name, Active Text, and 
Inactive Text properties to 32 characters for PicoPort and Mirius. 

• Increased allowable range of BACnet (MS/TP and IP) Server Analog objects’ Unit Value field 
from 255 to 65535. 

• Updated BACnet engineering units in the Units selection for BACnet (MS/TP and IP) Server 
Analog objects to be consistent with the latest BACnet specification. 

• Added BACnet Client/Server protocol selection to PicoPort and Mirius. 

• Added Data Bits selection setting to USB Serial Sniffer Settings for PicoPort and Mirius to select 
between 7 or 8 data bits. 

• Added selectable padding character to Generic Serial ASCII Encoded Decimal and Hexadecimal 
Numbers for encoded Database Data. 

• Changed the setting limitations for Modbus RTU Master’s and Modbus/TCP Client’s Num 
Registers and Num Discretes settings to depend on whether a write multiple function code is 
enabled (in addition to the existing check of whether 32-bit registers are used). 

• Removed the maximum value restriction of 123 for Modbus RTU Sniffer’s Number of Registers 
setting. 

• Removed database overlap restriction for Relinquish/Release Events. 

• Changed minimum length of User Name and Password authentication settings to 1 character for 
ETH-1000. 

• Added the Run USB Driver Installer option to the Help menu. 

• Fixed issue where importing a project does not flag the project as having changes. 

• Optimized configuration file size for Modbus RTU Master, Modbus RTU Slave, and Database 
Logic settings. 

• Added support for TLS1.1 and TLS1.2 encryption (HTTPS) to the Check for Updates feature. 
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 02.22.2021 

• V3.2.3.1 Release 

• Fixed issue when downloading a configuration to the ETH-1000 where the studio may stay at the 
“Waiting for Device to Become Ready” message. 

• Fixed help text of the Model Name setting under BACnet OEM Settings for the Mirius to show the 
correct default model name. 

• Changed the Mirius’s “Default Network Protocol” device setting to “Default Port A Protocol”. 
 
 
 

 12.17.2020 

• V3.2.3.0 Release 

• Added a new Normalized Reading (Float) parameter for each detector to Macurco Modbus 
Monitor. 

• Added a check to the BACnet MS/TP Device Object OEM Settings for PicoPort and Mirius to 
ensure that if one setting is changed, all must be changed. 

• Removed the Relinquish Default Event from the Default BACnet Mapping's available items for 
PicoPort and Mirius. 

• Fixed issue where device settings were not defaulted prior to reading the configuration from the 
device. 

• Fixed issue where reading the device's configuration or checking for a firmware update could 
execute multiple times. 

• Improved USB communication error handling and recovery. 
 
 
 

 06.08.2020 

• V3.1.3.3 Release 

• Fixed issue with ETH-1000’s BACnet/IP Server where objects were being shown at their 
database address times two in the Database pane. 

• Added all BACnet engineering units to the Units selection for BACnet/IP Server and BACnet 
MS/TP Server Analog objects. 

 
 
 

 05.27.2020 

• V3.1.3.2 Release 

• Added Modbus RTU Firewall Router protocol to PicoPort and Mirius. 

• Added support for a Relinquish Default Event to BACnet MS/TP Server for PicoPort and Mirius. 

• Added support for a Release Event to Metasys N2 Slave and Siemens FLN Slave for PicoPort 
and Mirius. 

• Added support for a Manual Trigger to Generic Serial Master transactions for PicoPort and Mirius. 

• Added support for a Receive Event to Generic Serial Slave transactions for PicoPort and Mirius. 

• Increased object memory capacity for PicoPort and Mirius by 6%. 
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• Added constant value support to the Bit Copy database logic operation to allow easily setting or 
clearing individual bits in the database. 

• Added duplicate point description check to Siemens FLN Slave. 

• Added a warning prompt if the user is about to save a blank project. 

• Fixed issue where studio would prompt to update firmware when USB communication issues 
cause the connected device's firmware version to be reported as V0.000. 

• Fixed issue where device settings are not validated when going online with a device. 

• Fixed sorting issue with the Address column in Diagnostics pane. 

• Fixed BACnet MS/TP Max Master setting description to correspond to the correct range of valid 
values. 

• Changed Internal Parameters to be collapsed by default for PicoPort and Mirius when going 
online or adding the device to the project. 

• Added support to update connected devices in bootloader mode while in Batch Update Mode. 

• Fixed issue with Batch Update Mode where the old firmware version was written to the log 
instead of the new firmware version for devices that don't automatically reset during the firmware 
update process. 

• Fixed issue with Batch Update Mode where a user may not be prompted before performing 
additional actions on the online device after performing a batch update. 

 
 
 

 11.26.2018 

• V3.0.3.7 Release 

• Fixed issue with Modbus /TCP Client service objects when 32-bit registers are used and the 
database data type is not 32 bits. 

• Fixed issue where device stays online but is not shown in Online Devices if errors occur when 
downloading a configuration. 

• Fixed issue where Product ID setting is sometimes marked with an error after going online with a 
device. 

• Improved UI performance of USB Serial Capture Window when connecting to a USB serial port. 

 

 

 

 07.24.2018 

• V3.0.3.3 Release 

• Updated Modbus RTU Slave configuration for PicoPort and Mirius to allow explicitly mapping 
coils and discrete inputs. 

• Reworked Database and Diagnostics to improve flexibility and performance. 

• Reworked Object List and related events to improve performance when adding, removing, and 
modifying items. 

• Fixed issue with item validation when using multiple protocols. 

• Added support for 1 Bit data type and starting bit in the database. 

• For Macurco Modbus Monitor, changed lowest sensor address from 13 to 1. 

• Removed database overlap restrictions on digital inputs for PicoPort and Mirius I/O to allow 
different bits within the same database location to be used. 
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• Fixed issue with group writes for Modbus RTU Master Coil Service Objects for PicoPort and 
Mirius. 

• Fixed issues with Batch Update Mode when multiple devices are connected when starting. 

• Improved USB driver installation. 

• Fixed issue in Project pane where removable, but non-movable, items could not be dragged to 
the trash. 

• Increased device reset timeout time when updating firmware. 

• Various performance improvements. 
 
 
 

 01.05.2018 

• V2.7.3.0 Release 

• Added an Override Release Trigger to Metasys N2 Master commandable service objects. 

• Added an Override Release Trigger to Siemens FLN Master commandable service objects. 

• Added validation check to BACnet Client, Metasys N2 Master, and Siemens FLN Master to make 
sure the write function is enabled to allow having a Relinquish Priority or Override Release 
Trigger. 

• Added support to trigger network configuration parameters to be overwritten by configuration file 
values on the PicoPort and Mirius after downloading a configuration. 

• Fixed issue when deleting an item from the project tree that has children that appear in the object 
list where only the first child would be removed from the higher level parent's object list. 

• Fixed database overlap error issues with DMX-512 Master data. 

• Added configurability to Macurco Modbus Monitor Baud Rate and Parity settings. 

• Added a "Disabled" selection to the Default Network Protocol for PicoPort and Mirius. 
 
 
 

 09.05.2017 

• V2.6.3.0 Release 

• Added support for the Mirius. 

• Added Macurco Modbus Monitor protocol. 

• Added “Write Triggering” setting to PicoPort and Mirius to select how writes are triggered on the 
device. 

• Added “Max Info Frames” setting to BACnet MS/TP Client and Server for PicoPort and Mirius. 

• Added “Fail-safe Timeout” setting to BACnet MS/TP Server for PicoPort and Mirius. 

• Added “Timeout” setting to Modbus RTU Sniffer for all devices. 

• Changed “Group Multiple Writes” setting to a drop-down for Modbus RTU Master for PicoPort and 
Mirius which now contains options for “Never”, “Optimized”, and “Always”. 

• Removed restriction on Generic Serial Master so that read-only database data can overlap with 
write-only database data. 

• Added support for frequency detection to the Pulse Input I/O object. 

• Added support for multiplier and offset scaling to the Pulse Input I/O object. 

• Added the “Contact Style” setting to Digital Input and Pulse Input I/O objects. 
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• Changed the “Pulse Counter” I/O object to “Pulse Input” since it now does frequency detection as 
well as pulse counting. 

• Renamed the Pulse (Analog) Output I/O object to Pulse Output. 

• Renamed the "Pin Change" option to "Any Edge" in the Pulse Input I/O object for the PicoPort 
and Mirius. 

• Changed the “Debounce Time” Pulse Input setting limits and description to better match the 
updated firmware changes. 

• Fixed issue with Modbus RTU Master where the “Group Multiple Writes” setting was enabled 
when function code 6 is used. 

• Added improvements to setting validation when accounting for disabled settings. 

• Fixed issue where non-enabled settings could show a value loaded from the project file instead of 
the fixed, default value. 

• Improved setting tooltips so that the tooltip is shown when the mouse is hovered over the text 
entry box as well as the setting name. 

• Fixed exception issue when a device is unplugged when the USB Serial Capture Window is 
capturing packets. 

• Fixed exception issue when a device is unplugged while downloading a configuration. 
 
 
 

 12.12.2016 

• V2.5.3.0 Release 

• Added the Port Diagnostics Window to view the number of bytes sent, received, and received 
with errors on either of the PicoPort’s serial ports. 

• Added settings for controlling the PicoPort’s status LED. 
 
 
 

 10.28.2016 

• V2.4.3.0 Release 

• Added Expand/Collapse and Expand/Collapse All Items Below options to the Project pane. 

• Fixed issue where errors were not shown on parent items after copying and pasting. 

• Fixed issue with the expanded/collapsed state of objects when copying and pasting. 

• Fixed issue where the recent file list is reset after upgrading to a new version. 

• Fixed issue with object memory usage calculation. 
 
 
 

 09.15.2016 

• V2.3.3.0 Release 

• Added a restriction so that read-only service objects cannot overlap with write-only service 
objects under the same protocol. 

• Fixed issues with Batch Update Mode when updating a device whose configuration is locked. 

• Fixed issue where the configuration on a locked device could be lost if a firmware update is 
performed as part of the download configuration procedure. 
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• Fixed issue where online devices could be dragged or copied and pasted to the device 
configurations when the upload option is not available. 

• Fixed issue where expanded state of items is not preserved when copying and pasting. 

• Fixed issue where the Save button is enabled when the studio first opens. 
 
 
 

 08.15.2016 

• V2.2.3.0 Release 

• Added support for configuration locking for the PicoPort. 

• Added support for Real-time Clock Settings in BACnet MS/TP Client and Server for the PicoPort. 

• Fixed issue in USB Serial Capture Window when saving PCAP files where proper format could 
not be detected when incomplete capture lines are received. 

• Fixed issue when entering non-ASCII characters (i.e. > 0x7F) in the Generic Serial Constant Data 
or List Matched Character where the hex value would change to 0x3F. 

• Fixed issue where items could be marked in error when not enabled. 

• Fixed issue where group box text in item settings was not gray for online devices. 

• Fixed issue where combo box text in item settings was not gray for disabled or read-only settings. 

• Updated application and project file icons. 
 
 
 

 06.22.2016 

• V2.1.3.1 Release 

• Fixed issue with Batch Update Mode where downloading a configuration to a device would not 
work. 

• Changed the default MELSEC Client port to TCP port 2009 for consistency with MELSEC Server. 

• Renamed the Port setting for MELSEC Client to TCP Port for consistency with MELSEC Server. 

• Changed MELSEC Client’s SLMP Service Object’s PC/Station Number to Node Number and 
Module IO Number to Processor Number to better match the SLMP specification’s terminology. 

 
 
 

 06.15.2016 

• V2.1.3.0 Release 

• Added support for the Database Matched Byte packet data object to Generic Serial. 

• Added ASCII entry option for Generic Serial Constant Data and List Matched Character packet 
data objects. 

• Renamed Generic Serial List Matched Byte to List Matched Character. 

• Renamed ETH-1000’s Register Remaps object usage title to Register Mappings. 
 
 
 

 05.11.2016 

• V2.0.3.11 Release 
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• Changed the error indicator to an octagonal stop sign shape with an exclamation. 

• Added support for a configurable Product ID for the PicoPort. 

• Added support for the PicoPort’s increased configuration file size. 

• Improved error message for the case of the configuration file size exceeding the device’s 
configuration file size limits. 

• Fixed issue with configuration parsing where certain Modbus Service Objects would not be 
added. 

• Fixed issue with downloading large configurations where the studio would seem to hang briefly 
before displaying the wait text. 

• Fixed issue where moving an item did not trigger unsaved changes. 

• Fixed issue where the studio shows available items when a device is no longer connected. 

• Fixed issue where the USB connection icon would not appear next to the online device after 
downloading a configuration to it. 

• Fixed issue when downloading configurations where sometimes the items under the online device 
used black text instead of gray. 

• Changed the behavior of item expanders so that when copying, downloading, or uploading 
configurations, the expanded state of each item is preserved. 

• Added fixed Timeout value to Sullair Master for consistency with other protocols. 

• Added the “Slave” designation to DeviceNet, EtherCAT, and PROFIBUS protocols. 

 

 

 

 03.01.2016 

• V2.0.3.7 Release 

• Added Generic Serial Master protocol. 

• Added Generic Serial Slave protocol. 

• Added Host - Network Pass-Through protocol for the PicoPort. 

• Added support for Internal Float (ADF), Internal Integer (ADI), and Internal Byte (BD) object types 
to Metasys N2 Slave. 

• Corrected FLN Slave object configuration settings so that the Default Value and Max Value no 
longer depend on the values of the Slope and Intercept. 

• Updated FLN Slave object setting description tooltips. 

• Fixed issue with duplicate database mappings in the online device if a configuration fails to 
download. 

• Improved database overlapping checks such that read-only mappings can now overlap with write-
only objects. 

• Changed BACnet MS/TP Client "Destination Address" setting name to "Destination MAC 
Address". 

• Removed the Kele EnGenius protocol selection from the PicoPort. 
 
 
 

 12.18.2015 

• V2.0.2.3 

• Added Batch Update Mode feature. 
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• Fixed issue with drag/drop behavior where an item could be pasted before a non-movable item. 

• Updated BACnet/IP BBMD BDT Entry setting tooltips. 
 
 
 

 12.03.2015 

• V2.0.2.2 

• Added the “My BDT Entry” object type to BACnet BBMD to support NAT and clarify that there 
must be an entry for the BBMD itself. 

• Fixed issues with parsing and drag/drop functionality for implicit children. 

• Fixed fatal error issue when attempting to download to a device when multiple devices of the 
same name are online with the studio. 

 
 
 

 11.20.2015 

• V2.0.2.1 

• Redesigned the device configuration workflow so that connected devices are no longer 
automatically added to Online Devices. Instead, discovered devices are shown in the available 
items pane when Online Devices is selected in the project pane. Devices shown under Online 
Devices are now read-only and show only the devices that the user has gone online with. 

• Changed Offline Devices to Device Configurations in the project pane. 

• Updated tooltip descriptions for Device Configurations and Online Devices in the project pane. 

• Modified behavior of New Project, Save Project, and Load Project to match the redesigned 
workflow. 

• Added an “Add” option to the edit menu and toolbar to add the selected available item to the 
project. 

• Added automatic checking for updates once a week. This feature can be disabled in the Help 
menu. 

• Fixed issue where USB devices would still be shown as connected after being disconnected. 

• Added support for non-movable items in the project pane. 

• Added support for dragging a device configuration onto an online device to download the 
configuration to that device. 

• Added a device selection menu when downloading a device configuration when multiple, 
compatible online devices are present. 

• Fixed issue with item selection when dragging and dropping to paste an item. 

• Renamed the object list’s “Edit” option in the context menu to “View”. 

• Changed the USB icon for discovered/online devices. 

• Added a new group and icon for Limited Ethernet discovered/online devices. 

• Fixed issue where studio would open as minimized if it was previously closed while minimized. 

• Changed which item is selected after an item is deleted, so that multiple items can be removed 
quicker. 

• Fixed issue where database syncing was not being suspended while a device is resetting. 

• Added support for increased Object Memory size for the PicoPort. 

• Added support for Persistent User Parameters and Initializer Objects for the PicoPort. 
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• Added PWM Mode selection to PicoPort’s I/O settings for Pulse (Analog) Outputs. 

• Renamed PicoPort’s Analog (PWM) Outputs to Pulse (Analog) Outputs. 

• Increased PicoPort’s BACnet Vendor Name and Model Name to support up to 32 characters. 

• Fixed issues where a disabled setting could show an error. 

• Fixed issue with the Serial Capture Window where buttons would not enable/disable properly. 

• Fixed range limits on Timeout, Scan Rate, and Response Delay protocol settings. 

• Changed BACnet MS/TP default APDU Timeout time to 1 second. 

• Added check for BACnet MS/TP Max Master being less than the MAC Address. 

• Added Number of States and Offset By One settings for BACnet Multi-State objects. 

• Improved error reporting when loading project files and uploading configurations from devices. 

• Added support for importing multiple projects at once. 

• Fixed issues with Database pane scroll position resetting to the top. 

• Updated the icons used for Online Devices in the project pane. 

• Added functionality to change the Online Devices icon from grey to green when the studio is 
online with one or more devices. 

• Added discovered devices count icon to the Online Devices icon which displays the number of 
devices in the Discovered Devices list. 

• Fixed issue where Database Endianness setting would be overwritten when opening a project 
file. 

• Fixed issue where the summary pane was not updated after opening a project file. 

• Improved handling of configuration files which exceed the available object memory. 

• Improved behavior of items when object memory is full. 

• Added color to the object usage bar to show yellow and red when object usage reaches 75% and 
90%, respectively. 

• Fixed behavior where database value byte ordering would change based on the configured value 
of the Database Endianness setting. 

• Removed 4800 baud rate selection for BACnet MS/TP. 

• Added APDU Timeout field to BACnet protocols. 

• Added Number of APDU Retries to BACnet protocols. 

• Changed the open project’s file type descriptions. 

• Added studio version tag to saved project files. 

• Memory optimization improvements. 

• Performance optimization improvements. 

• Various bug fixes 
 
 
 

 04.01.2015 

• V1.3.3.0 Release 

• Reworked item copy functionality to be split into a copy and paste operation, allowing items to be 
copied between different parent items. 

• Add Inverted, Auto Reset, and Bitmask trigger options to database logic enable triggers. 

• Added Bit Copy, Indirect Copy, Flag Test & Set, Value Change Detection, Multiplexer, and Byte 
Reverse database logic operations. 
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• Added Protocol Format selection under USB Serial Sniffer Settings. 

• Added PWM Frequency setting under GPIO Analog (PWM) Outputs for the PicoPort. 

• Added the Online Database Logic Overview link in the Help menu. 

• Changed BACnet MS/TP Client static device destination address limit to 254 to support MS/TP 
slave-only addresses for all Millennium Series devices. 

• Fixed issue where default device settings are not shown when a device has no configuration. 

• Fixed issue where some database mappings were not removed from the database properly. 

• Fixed issue where a disabled setting could be marked as invalid and show an error. 

• Fixed issues when exporting the object list and database mappings when settings are blank. 

• Removed extra space character when exporting object list and database mappings. 

• Improved USB device detection. 

• Improved responsiveness when detecting if the ETH-1000 is ready. 

• Added Network Information which includes IP Address, Subnet Mask, and Default Gateway to the 
device information shown for the ETH-1000. 

• Fixed issue where USB device may not be detected if the driver takes a long time to install. 

• Fixed issue when editing database values where typing the escape key would not cancel the edit. 

• Reordered firmware file list in the firmware selection dialog box so that the latest firmware file is 
first. 

• Fixed issue where the firmware file list in the firmware selection dialog box was not sorted 
correctly. 

• Fixed issue when updating ETH-1000 coprocessor firmware where an error message could be 
displayed when the main processor firmware is up to date. 

 
 
 

 01.07.2015 

• V1.2.3.7 Release 

• Fixed issues with Modbus Slave/Server overlapping instances errors. 

• Added performance optimizations for error checking and database mapping updates. 

• Fixed issue where users could delete columns from the Object List and Database Object View. 

• Added support for parsing XML tags with blank/empty values. 
 
 
 

 12.08.2014 

• V1.2.3.6 Release 

• Fixed issue generating EDS file for DNET-1000. 

• Updated default EDS Device Revisions. 

• Device discovery library updates. 
 
 
 

 11.25.2014 

• V1.2.3.5 Release 
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• Added description tooltips to all settings and items. 

• Added links in Help menu for product and protocol driver manuals. 

• Added link in Help menu to check for software updates. 

• Added Export Database Mappings option in the File menu to export the objects view of the 
Database pane. 

• Removed database overlap checks for GPIO for the PicoPort. 

• Changed BACnet MS/TP Client static device destination limit to 254 for the PicoPort to support 
MS/TP slave-only addresses. 

• ICC Discovery Library changes. 

• Fixed Generic Socket Client validation checks. 

• Fixed issue where Online Device is always moved to Offline Devices if it times out while resetting. 

• Fixed issue when exporting Object List that has comma characters in object names. 

• Fixed M-Bus Destination Address checks for Fixed Data Structure. 

• Added character limit checks for FLN Slave On Text and Off Text. 

• Fixed XML writing and parsing issue with Timeout Objects’ Value for ETH-1000. 

• Added valid text check to FLN Application Descriptor. 

• Made Modbus Word-Size Register and Word Count 32-bit options enabled by default. 

• Added read-only setting to Modbus Default Mapping to indicate what the default mapping is. 

• Added read-only settings to MELSEC Service Object for the Network Number, PC/Station 
Number, and Module IO Number. 

• Added a Node item to Sullair Master and moved the Address setting to the node. 

• Fixed object usage for ETH-1000 database logic so that it doesn’t subtract from the device’s 
object memory. 

• Fixed issue when updating firmware on ETH-1000 where configuration could not be restored. 

• Changed Modbus Slave/Server Register Remaps to Register Mappings. 

• Changed GFH protocol name to Erlab GFH. 

• Changed VeriSens protocol name to Baumer VeriSens. 

• Changed Chillgard protocol name to MSA Chillgard. 

• Changed Basys protocol name to TCS Basys 

• Changed AO Smith protocol names to A.O. Smith. 

• Changed PROFIBUS protocol name to PROFIBUS DP-V1. 

• Removed Kele PowerTrak protocol from the PicoPort. 

• Changed Digital/Binary service objects’ Data Type to 1-Bit instead of 8-Bit Unsigned. 

• Added number of stop bits designation to all parity selections. 

• Changed display of Object Usage in the Summary pane for some items to display in number of 
objects free instead of percent free. 

• Fixed Device Info spacing for XP version. 

• Updated project item error tooltips for XP version so entire error tree is displayed. 

• Added “DO NOT REMOVE POWER OR DISCONNECT THE DEVICE” message to updating 
firmware status. 

• Minor bug fixes. 
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 08.25.2014 

• V1.2.3.0 Release 

• Added the ability to copy items in the Project pane. 

• Added the ability to reorder items in the Project pane. 

• Added an Edit menu and toolbar buttons to perform copying and removing items in the Project 
pane. 

• Added floating point support as a native database type. 

• Added USB Virtual COM Port configuration settings. 

• Added USB Serial Capture Window. 

• Added FLN Master protocol. 

• Added Toshiba Computer Link Master protocol. 

• Added USB Serial Sniffer Settings protocol to use for packet capturing. 

• Added Trigonometric Operations to Database Logic. 

• Added Random operation to Database Logic. 

• Added ability for unused host port pins on the PicoPort to be used as GPIO pins 6 - 9. 

• Added OEM Settings to BACnet Device Object for the PicoPort to configure custom Vendor ID, 
Vendor Name, and Model Name. 

• Added Relinquish Priority Trigger to commandable BACnet Client service objects. 

• Added Default COV Increment setting to Analog BACnet Server objects for PicoPort and ETH-
1000. 

• Fixed configuration entry for ETH-1000 BACnet/IP Multi-State Relinquish Default setting. 

• Added additional checks to network settings for ETH-1000 and now allow a Default Gateway of 
0.0.0.0 to indicate that the field is unused. 

• Changed Alarm objects so that there is only one available object instead of 20 separate objects. 

• Added support for all data types to Alarm objects. 

• Removed unsupported 8-bit data types from Modbus 32-bit registers. 

• Added support for hexadecimal numbers in value and multiplier settings. 

• Improved Object List column ordering, sorting, automatic resizing, and exporting. 

• Updated drag and drop visualization. 

• Added fixed parameters for Chillgard Monitor, Kele PowerTrak, and Kele EnGenius protocols. 

• Fixed setting validation issues. 

• Fixed issue where settings do not update after upload or project loading. 

• Fixed issue in detecting overlapping objects in the database. 

• Fixed issue in parsing MELSEC Client configurations with only SLMP Connection Objects. 

• Fixed issue with M-Bus LVAR setting. 

• Fixed incompatibility with non-English Windows installations in the Device Driver Installation 
Wizard. 

• Fixed issue where firmware update failed when erasing flash on some machines. 

• Fixed issue where an error occurred when saving a project with certain errors.  

• Fixed issue where Diagnostics pane would turn red when clicking on the Reset Status Counters 
button. 
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• Fixed handling of failures if downloading a configuration to a device is unsuccessful so that the 
offline and online device configurations are restored. 

• Fixed issue where context menu would appear then disappear when right clicked in some cases. 

• Fixed issue in XP version when multiple firmware files must be selected. 

• Changed default layout so that the Database and Diagnostics panes are shown. 

• Added Description setting to Timeout Objects and I/O objects. 

• Changed the name of Reflect Status Object to Diagnostics Object. 

• Removed dash characters from default PROFINET Device Name. 

• Changes some setting names to be more descriptive. 

• Changed firmware revision string format. 

• Fixed resolution issues with product images. 

• Added progress percentage to upload and download operations. 

• Added a connection icon next to online devices to show what interface type it was discovered on. 

• Added Online Tutorial Videos option to the Help menu. 

• Improved text layout in the Summary pane. 

• Updated USB drivers. 
 
 
 

 11.20.2013 

• V1.0.3.6 Release 

• Added UDP Port field to BACnet/IP Client, BACnet/IP Server, and BACnet/IP BBMD protocols. 

• Fixed issue in BACnet MS/TP Client where Priority selection was lost when downloading or 
saving. 

 
 
 

 11.15.2013 

• V1.0.3.5 Release 

• Fixed M-Bus Variable Data Structure VIB selection values. 

• Added Ctrl+Shift+S keyboard shortcut for the “Save Project As…” File menu option. 

• Fixed issues with database colorization and object overlapping checks when the device 
description field changes. 

• Fixed error description when objects overlap in the database to include the proper hierarchy. 

• Fixed issues with the protocol object list when multiple connections objects are used. 

• Fixed issue where deleting connection objects did not remove service objects from the protocol 
object list. 

• Fixed issues where database attempts to communicate to device while device operations are in 
progress. 

• Fixed database usage for PicoPort’s Network port so that it uses the max object usage of any 
protocols configured on the port. 

• Added check when parsing a device configuration to generate an error if an item could not be 
added to the project. 
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• Changed heading of Available Items pane from “Available Status Items” to “Available Object 
Extensions” 

 
 
 

 09.27.2013 

• V1.0.3.4 Release 

• Changed Modbus fields Start Status and Number of Statuses to Start Coil/Input and Number of 
Coils/Inputs. 

• Removed floating point number formatting limitation of 6 digits after the decimal point. 

• Capitalized all occurrences of PROFINET and PROFIBUS strings. 

• Added database logic support for Millennium Series gateways. 

• XML tag optimizations 

• Fixed crash issue when loading a project. 

• Added an Operation Type selection to the Not, And, Or, and Exclusive Or database logic 
operations to select bitwise or logical. 

• Fixed XML parsing error where loading a blank string resulted in a value of 0. 

• Added description, input multiplier and output multiplier fields to all database logic operations. 

• Changed value tolerance for hysteresis filter to be able to be a database location complete with a 
multiplier. 

• Changed database logic constant value to a floating point instead of an integer. 

• Fixed database usage calculation for some database logic operations. 

• Minor bug fixes. 

• Added a description field to each device so that a user may label device configurations in a 
project. 

• Fixed issue where database updating stops working when ETH-1000 is reset. 

• Added feedback to database synchronization. The database will now turn red if there is a 
synchronization issue with the online device. 

• Fixed issue where database synchronization did not work after a device is unplugged and 
plugged back in. 

• Fixed issue where device sometimes is not removed from the project tree when right clicking and 
selecting Remove. 

• Added Device menu options to the project tree context menu so that right clicking on a device or 
object below a device will allow you to download, upload, reset, or read device information. 

 
 
 

 09.03.2013 

• V1.0.3.3 Release 

• Added SPI Slave protocol to PicoPort Host port. 

• Added Exponential, Nth Root, and Logarithm operations to Database Logic. 

• Added a check when loading a recent project to prompt the user if there are unsaved changes. 

• Changed the order of loading a project file and uploading configurations from online devices 
when loading a project. 

• Changed the column headers in the Object List to include group names of settings. 
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• Fixed Generic Socket Client and Server to not require a Destination Port if it is not configured to 
transmit. 

• Fixed Generic Socket Server duplicate connection setting checks to only check for duplicate 
source ports. 

• Fixed Melsec Client to detect standard device codes when manually entered as an “Other Device 
Code”. 

 
 
 

 08.13.2013 

• V1.0.3.2 Release 

• Added support to differentiate dependent settings as disabled or read-only. 

• Fixed issue where some protocol objects would not appear in the database. 

• Fixed update issue when editing a database address and clicking off in the same row. 

• Modified BACnet BBMD protocol tree structure to match BACnet Client and BACnet Server. 

• Optimized database update and validation times when database settings change. 

• Added Debounce Time to Pulse Counter. 

• Fixed Timeout Object xml issues for all devices. 

• XML object order is now preserved when parsing configuration files. 

• Added Modulo operation to the Database Logic. 

• Fixed issue where Object List always scrolled to bottom of the list. 

• Improved Object List auto-scrolling when sorting. 

• Added support to navigate to an object from the Object List by double clicking, typing the Enter 
key, or right clicking and selecting Edit. 

• Fixed issues where edits to settings are not updated when saving and downloading. 

• Added support for hitting the Enter key while in a setting field to apply the new value. 

• Added globalization support for XML writing and parsing. 

• Fixed issues with database colorization. 

• Fixed issue where Database Logic Enable Triggers could not overlap. 

• Fixed Basys Master read-only and write-only service object issues. 

• Changed Basys Master Read/Write Command field label to Parameter and updated the K, L, and 
M options. 

 
 
 

 07.31.2013 

• V1.0.3.1 Release 

• Fixed crash issue when loading an invalid layout. 

• Fixed various field and message texts. 

• Added Pulse Counter to GPIO for PicoPort. 

• Added Database Logic for PicoPort. 

• Fixed underscore character issue in configuration field labels. 

• Left-Aligned the Database tooltip text. 

• Fixed issues when closing application with unsaved changes. 
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 05.31.2013 

• V1.0.3.0 Initial Release 
 


